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Open the schedule for this lesson 

1. On the toolbar, choose File.  

2. In the Files and Templates: Open and Save Options section select Open 
Samples or Lessons. The Open a Sample Chart dialog displays. 

3. Under Select a Folder below to Open, select Lessons.  The Lesson 
schedules will display in the window to the right. 

4. Pick Lesson 03 Starter Schedule.mlj.  

5. Save the schedule to an accessible folder on your computer. Choose the 
File tab.  In the Files and Templates: Open and Save Options section, 
choose Save As….  In the menu that displays choose Chart.  Name, then 
save the schedule. 

In this lesson you will learn how to: 

• Add a block of freeform text 

• Customize freeform text 

• Add dates to symbols and adjust the date’s position 

• Add text to a symbol and adjust the text’s position 

• Add text in the middle of a bar using symbol text 

• Add angled text 

• Vertically move symbol text 

• Add a symbol note with picture and move it. Lesson 3 – Work with Text 

Add a block of freeform text 

1. Click the (T) Text tool in the toolbox. 

2. Click in the schedule area, to the right of the Nail on shingles step. The flashing cursor displays. 

3. Type 3-Man crew to arrive. 

4. Press Enter to split the text onto a new line. 

5. Type by 8am daily. 

6. Next to by 8am daily. Type in the following code color 
code <rgb:21,129,165> then click away from the text. This 
code will change this line of text to the color teal.  3-Man 
crew to arrive text will not be affected.  

 

Lesson 3 Starter Schedule 

Added and Color Coded Freeform Text 
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Freeform text will not move with a task row -- it is placed relative to the page. 

Freeform text placement can be adjusted by using the arrow tool in the toolbox. 

Customize the freeform text block 

1. Click the () Arrow tool in the toolbox. 

2. Click the freeform text 3-Man crew to arrive by 8am daily..  The toolbar changes to the Selection tab Current Object: Freeform 
Text which contains all the selected freeform text options.  Follow the numbers to change the selected freeform text properties. 

In the Background Color section: 

3. For Fill Color choose gold or your color choice. 

4. For Effects choose Fade to Bottom. 

5. Uncheck Transparent (Disables Background Color). When this option is checked on the background of the freeform text will not 
color (is transparent.) 

In the Font section: 

6. For Text Style choose the (B) Bold, (I) Italic and (U) Underline icons. 

7. For Text Color choose medium brown or your color choice. The first line of freeform text 3-Man crew to arrive color will change. 
The second line of freeform text  (by 8am daily.) that has been color coded will not be affected. 

8. For Horizontal Alignment choose the middle icon. 

9. Change the font size to 20. 

In the Border section: 

10. For Color choose dark brown or your color choice. 

11. For Line Type choose 9. 

12. Check on Draw Border. This will 
cause the dark brown border to 
draw. 

Customized Freeform Text Block 
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Display dates with symbols 

Globally 
1. In the toolbox, double-click the symbol, that is used for 

the start symbols on your schedule.  The Symbol Options dia-
log box displays. 

2. Click the Text/Date Properties tab. 

3. Under Date Placement, choose Above and Center. 

4. Click OK.  Above each symbol its date is displayed. 
To change the symbol date format, choose Dates | Date 
Related Settings | Set Symbol Date Format.  Choose from a 
list of predefined formats or create a custom format. 

Individually 
1. Click the () Arrow tool in the toolbox 

2. On the schedule, in the task row for Tear off old roof click     (the end symbol.) 

3. The toolbar changes to the Selection tab Current Object: Symbol which contains all that symbol’s options.  Follow the numbers 
to change the selected symbol’s date properties. 

4. On the Text tab in the Date Placement section for Vertical select 
Above.  The date will now display on that symbol. (In the same 
format as the start symbol’s date.) 

5. Change just this symbol’s date format. In the Text section for Cus-
tom Date, type in the following code: ddd. M/d/yy.   

6. Press the Apply Text Changes button.  The date 
Tue. 5/25/21 will display above the end symbol. 

Adjust symbol date position with the keyboard 

1. Click the () Arrow tool in the toolbox. 

2. On the schedule, click once on the symbol with the symbol date to be moved.  

3. Hold down ALT + CTRL. 

4. Click the arrow keys on the keyboard to move the symbol date around the symbol.  The symbol date will move as you click the 
arrow keys. 

Date Displayed on Symbols 

Customized Date Displayed on a Symbol Select the  question mark icon to view all availa-
ble codes for the custom date format. 
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Annotate a symbol with symbol text 

1. Click the () Arrow tool in the toolbox 

2. Click (the end symbol for the Get materials step).  The toolbar changes to the Selection tab Current Object: Symbol which 
contains all that symbol’s options.  Follow the numbers to add and customize this symbol’s text. 

3. In the Text section for Line 1 type in Materials:. 

4. Press the Apply Text Changes button. 

5. In the Text section click Text Overrides for Line 1.  The Symbol Text Line 1 
Overrides dialog box will come up.   

a. Under Text Color Override click the Press to Change Color rectangle 
to open the color palette. Choose light brown or your color choice 

b. Under Text Attributes Overrides check on Italic Override. 

c. Click OK. 

6. In the Text section for Line 2 type in Tar Pa-
per, Shingles, Nails. 

7. Press the Apply Text Changes button. 

8. In the Text Placement section, for Horizontal 
choose Right. 

9. In the Text section, for Date Suffix, type in 
Est.. 

10.Press the Apply Text Changes button. 
You will not see any change until the next 
step. 

11.In the Date Placement section, 
for Vertical choose Below. 

 

Adjust symbol text position with the keyboard 

1. Click the () Arrow tool in the toolbox.. 

2. On the schedule, click once on the symbol with the text to be moved. 

3. Hold down the ALT key. 

4. Click the arrow keys on the keyboard to move the text around the symbol.  The text will move as you click the arrow keys. 

To change the default symbol text style, color, size and attributes choose Format | Default Text | Symbol Text.  By selecting a symbol or group of 
symbols they may have their own symbol text size, color and attributes.  Symbol date is considered symbol text thus it will have the same look.  
Symbol text color override can be set in the toolbox, Symbol Options dialog choose the Color/Pattern/Size/Shadow tab.  

Added and Customized Symbol Text 
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Add text in the middle of a horizontal bar using symbol text 

1. Click the () Arrow tool in the toolbox. 

2. Click the start symbol for Tear off old roof.  The toolbar changes to the Selection tab Current Object: Symbol which contains 
all that symbol’s options.  Follow the numbers to add symbol text to the horizontal bar. 

3. In the Text section for Line 1 type in Smith Const.. 

4. In the Font section, for Color choose Gold or your color choice. 
This will also change the symbol’s date color. 

5. Press the Apply Text Changes button. 

6. In the Text Placement section, for Vertical choose Middle. 

7. In the Text Placement section,  for Background 
choose Transparent. 

8. In the Text Placement section, check on Center Text 
on Bar. 

Draw symbol text at an angle  

1. Click the () Arrow tool in the toolbox. 

2. Click the star symbol for Put down tar. The toolbar changes to the Selection tab Current Object: Symbol which contains all 
that symbol’s options.  Follow the numbers to add angled symbol text. 

3. In the Text section for Line 1, type in RAIN SCHEDULE. 

4. Press the Apply Text Changes button. 

5. In the Font section for Color, choose teal or your color 
choice. 

6.  In the Font section, select the (B) Bold icon. 

7. In the Font section, for Size select  18. 

8. In the Text Placement section, for Vertical choose Above. 

9. Check on  Draw Text at Angle.   

Angled text will only show the first line of text as a single 
line of text regardless of how many lines of text are en-
tered.  

The default angle is set to 45 degrees.  To change the 
angle select Tools | Program Options | Edit | Angle for 
Angled Symbol Text . 

Always use the left-most symbol to enter text for a bar. 

Use Symbol Text  when text needs to "stick" to a task 
or symbol when the schedule updates. 

Text in the Middle of a  Horizontal Bar 

Angled Text 
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Vertically move symbol text 

1. Click the () Arrow tool in the toolbox. 

2. On the schedule in the task row for Nail on shingles click the end symbol.       

3. The toolbar changes to the Selection tab Current Ob-
ject: Symbol which contains all that symbol’s options.  
Follow the numbers to change the selected symbol’s 
date properties. 

4. In the Text section, for Line 1 type in Complete.  Line 
2 type in upon inspection. 

5. Press the Apply Text Changes button. 

6. Choose the Tools tab.  

7. In the Customize section choose Symbol Text Move.   

8. Under Symbol From Toolbox choose the fourth symbol in the list, the plus symbol (best to use 
a symbol that is not being used on the schedule). In the toolbox the symbol will change to 
shape #28, an invisible symbol. 

9. Under Vertical Link From Toolbox, choose the second vertical link in the list, the dotted line 
with arrow. 

10.Choose OK. 

11.On the schedule, click and hold on the symbol with the Complete upon inspection text. 

12.Hold down Ctrl + T. 

13.Drag to move the text to the task row above. The text is no longer attached to the end 
symbol on Nail on shingles.  It is now attached to a blank symbol on the task row 
above. 

14.Reposition the text Completion upon inspection by repositioning the symbol it is attached to now. Click on the text in the sched-
ule and the symbol will be selected.  The toolbar changes to the Selection tab Current Object: Symbol which contains all of that 
symbol’s options.  Follow the numbers to change the selected symbol’s date properties. 

15.Use the calendar icon to change the symbol’s 
date to 5/27/2021. 

16.Change the Time to 24:00. Now the text will be 
inside the schedule’s border. 

17.Choose the Size/Color tab. 

18.In the Other Overrides section, under Vertical 
Symbols Position choose 2 levels down.  Now the 
text will be just above the symbol. 

Vertically Moved Symbol Text 
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Symbol Note with Picture 

Add a picture to the schedule and give it a tag for use in a symbol note 
1. On the Insert tab, in the Picture, Legend section, choose Picture from File. Navigate to the Program Files\KIDASA\Milestones 

Professional 2021\Samples\Lessons and choose dumpster.jpeg 

2. When the picture cursor appears, click on the schedule to add the picture.  Drag a corner of the picture to make it larger. 

3. With the () Arrow tool in the toolbox click the picture which is now on the schedule.  The toolbar changes to the Selection tab 
Current Object: Picture which contains all the selected picture's options.  Follow the numbers to change the picture’s properties. 

4.  In the Automation Tag, type in dumpster to name the picture.  

5. Press the Apply button. 

6. Choose Convert to Embedded Picture. 

7. In the Page section, for Current Page enter 2. 

8. Press the Update Page button. The picture will be moved to page 2 and now is ready to be used in a note. 

Add a note with a picture to a symbol 

1. Click the () Arrow tool in the toolbox.  Click the end symbol for Tear off old roof.  

2. The toolbar changes to the Selection tab Current Object: Symbol. At the bottom of the toolbar choose the Notes tab. The 
toolbar now displays symbol note properties.  Follow the numbers to add a note with a picture. 

3. In the Symbol Note Display section, check on Display Note on Schedule.  

4. In the note text box type in  

a. Dumpster removal by Waste Management. 

b. Press the keyboard Enter and type in the following markup code to 
have the picture show in the notes on the schedule.  <image 
tag=“dumpster”> (The dumpster in the tag refers to the picture which 
was “tagged” dumpster in an earlier step.) 

c. Press Enter.  Then type in the following: Thursday 
<i><b><rgb:255,0,0>   (Anything inside <> is a “markup code” used to 
change the characteristics of that line of text  <i> for Italic, <b> for 
bold, and <rgb:255,0,0> for red.) 

5. Press the Apply Text Changes button.  Use hard line breaks to control the line breaks in the displayed note, as text is not word 
wrapped. A line is limited to no more than 150 characters 

Before an image can be shown in a symbol note, it has to be added to the file.   

The size of the image on the schedule determines the size that will be shown in the symbol note.  Drag the corner of the picture to resize 
the picture  to the size you would like in the note.  

Moving a picture to a page does not add a page to the file.  It stores the picture on that page. The Manage Pictures option on the Tools menu 
makes it easy to find, move from page to page or delete a picture. 

If sharing the schedule with other users of Milestones Professional the picture needs to be embedded in the schedule. 

Images need to be named to display  in a note.   

Symbol Note with Picture 

To set symbol note default properties for text and look 
choose Format | Default Text |Symbol Notes. 
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Format and move the symbol note just added 

1. Click the () Arrow tool in the toolbox.  Click the end symbol for Tear off old roof.  

2. The toolbar changes to the Selection tab Current Object: Symbol. At the bottom of the toolbar choose the Notes tab. The 
toolbar now displays symbol note properties.  Follow the numbers to change the selected symbol note’s properties. 

3. Choose B for bold. 

4. Select the color rectangle to open the color palette. Choose Teal or your color choice. 

5. Choose 11 for font size. 

6.  For Connector Type choose the third option from top. 
 
 

7. For Color choose Teal or your color choice. 

8. For Background Color choose Yellow or your 
color choice. 

9. For Target Color choose Aqua or your color 
choice. 

10. For Frame Color choose Teal or your color 
choice. 

11. For Special Effects choose Fade to Bottom. 

12. For Frame Type choose a bold line. 

13. Use the direction controls to move the sym-
bol note.  (Or using the mouse, click on the 
note and drag it to the space next to Put 
down tar paper.) 

Only Dumpster removal by Waste Management text will be affected by this selection. 

The connector draws a link between the notes box and the symbol. 

Default symbol note formatting can be set by selecting the Format | Default Text | Symbol Notes.  
 
Use Note Text (or symbol text) on dense schedules when text needs to "stick" to a task or symbol when the schedule updates. 
 
To have text stick to a task without displaying a symbol, consider using a comment symbol.  A comment symbol can be a blank symbol or a very 
small symbol on a task row.  The comment symbol is ignored when computing start date, end date and duration so it can be placed anywhere on 
the schedule.  To create a comment symbol, just double-click any unused symbol in the toolbox and choose Comment Symbol under the Symbol 
Shape tab. 

Symbol Note with Picture 

Only Dumpster removal by Waste Management text will be affected by this selection. 


